Gravity: How fast do objects fall?
Teacher Version
(Grade level: 4 – 7)

*** Experiment with Audacity to be sure you know how to do what’s needed for the lab***

Kinematics is the study of how things move – their position, velocity, and acceleration. Acceleration is always due to some force acting on an object, in a car this force is provided by the engine or the brake pedal. Today, we will focus on a particular force that we experience constantly – the force of gravity. In this lab we'll use a computer program to mark the times at which washers on a string hit the ground, and use these measurements to calculate the velocity of the string and to see whether it accelerates. We'll also look at whether the mass of an object (the amount of “stuff” in it) affects how fast it falls.

California Science Content Standards:
• 1. Motion and Forces: Newton's laws predict the motion of most objects.
• 1e. Students know the relationship between the universal law of gravitation and the effect of gravity on an object at the surface of Earth.
• 2. Conservation of Energy and Momentum: The laws of conservation of energy and momentum provide a way to predict and describe the movement of objects.
• 2c. Students know how to solve problems involving conservation of energy in simple systems, such as falling objects.

Prerequisites:
Basic arithmetic and calculator skills (subtraction and division)

Complete List of Materials:
• 1 laptop with microphone (either built-in or separately attached) and the program Audacity installed (see instructions on downloading and installing Audacity below)
• 1-2 calculators
• 1 meter stick (with metric markings)
• 1 large paperback book or workbook
• 1 piece of string with a metal weight tied at the end and 5 metal washers tied along it at 30cm separation (Part 1 only)
• 3 pieces of aluminum foil (about 6in long, but the precise size does not matter)
• 1-2 thick textbooks (Part 2 only)
• 2 large marbles (Part 2 only)
• 1 ping-pong ball (Part 2 only)
• 1 cardboard tube (eg: from a paper towel roll) (Part 2 only)

Instructions for downloading and installing Audacity on your computer:
1. Go to the website: http://audacity.sourceforge.net/
2. Click on “Download Audacity 1.2.6a”
3. Depending on your type of computer you have, download the appropriate version (Mac users: if you aren’t sure what kind of processor you have, click on the blue Apple icon in
the top left corner of your screen, then click on “About this Mac”. The processor line will tell you whether you have Intel or PowerPC.

4. Once you click on the appropriate link, follow the “Installation Instructions” on the Audacity website. Click on the Audacity icon to launch the application.

5. Make sure the microphone is working by clicking the record button and tapping the table next to the computer a few times. To get rid of the recording, go to Edit→Undo.

6. Make sure the time under the “Selection Start:” at the bottom of the screen is set to **hh:mm:ss + milliseconds**.

**Preparation and Lab Notes:**

- Download and install Audacity according to the instructions below. Make sure the microphone is working properly.
- Open Audacity on each laptop that the students will be using.

**Key Concepts:**

- **Velocity** = change in distance ÷ change in time
- **Acceleration** = change in velocity over time (we say an object is *accelerating* if it is speeding up and *decelerating* if it is slowing down)
- Gravity accelerates all objects at the same rate (regardless of mass). This means that as an object begins to fall, it moves faster and faster (its velocity increases). Heavy and light falling objects will reach the ground at the same time.

**Introductory mini-lecture:**

Kinematics is the study of how things move – their position, velocity, and acceleration. **Position** tells us where an object is (eg: that car is on the corner of 1st and 2nd street). **Velocity** indicates how fast (speed) and in what direction the object is moving (eg: the car is driving south at 30 miles per hour). When we report the velocity in “miles per hour”, what we are really saying is that the car is going just fast enough that it will change its position by 30 miles in a time of 1 hour. If I tell you that another car will drive 40 miles in 2 hours, what must its speed be? What math problem did you do there? – You divided 40 by 2 to find the miles it will go in one hour. In general the average velocity over a time period is the distance traveled divided by the time interval.

In the real world, cars don't always move at a constant velocity. They have to slow down and stop at traffic lights, then speed up again, once the light turns green. **Acceleration** is the term used to describe how quickly the velocity of an object is changing. Large acceleration corresponds to suddenly speeding up (the driver of the car hits the gas pedal); large deceleration would be a car suddenly slowing down (the driver hits the brakes).

Acceleration is always due to some **force** acting on an object, in a car this force is provided by the engine or the brake pedal. Today, we will focus on a particular force that we experience constantly – the force of **gravity**. This force always pulls downward (aside: what is really meant by downward? Why don't people in Australia fall off the Earth?). Gravity thus causes objects to have a downward acceleration. What this means is that (unless something stops it) an object that starts at rest will acquire some downward speed, which will constantly keep increasing. Under the force of gravity, objects fall faster and faster until they hit something.

In this lab we'll use a computer program to mark the times at which washers on a string hit the ground, and use these measurements to calculate the velocity of the string and to see whether it accelerates. We'll also look at whether the **mass** of an object (the amount of “stuff” in
it) affects how fast it falls. What do you think – if I drop a marble and a ping-pong ball at the same time, which one will hit the ground first? [try it on the spot]. Looks like they fall together. In the second part of the lab, we'll measure more carefully whether mass affects gravitational acceleration.

**Part 1 – Distance versus Time for a Falling Object**

In this first part you will measure the acceleration of gravity directly by calculating how the velocity of a falling object changes with time. You will use the microphone on your computer to accurately measure the time it takes for washers to fall different distances.

**Procedure:**

1. Separate the Data Diagram sheet from your lab. It should be the last page.
2. Your lab kit should include a long string with washers tied to it. One person should stand up and dangle the string so that it hangs down straight and with the metal weight on the bottom just touching the ground. The other person should **use a meter stick to measure the distances between the washers. Fill in your results in the “Distances” column of the Data Diagram.**

**TEACHER NOTE**
Make sure all distance measurements are done in cm!

**TEACHER NOTE**
If students are confused about what part of the washer to measure to, encourage them to think about the relevant distance for how far the washers fall before they make a sound (either the bottom of the washer or its center is reasonable, and should not make much difference in the results)

3. **Place a large paperback book or workbook under a piece of aluminum foil on the floor. Place the computer on a chair nearby.**

4. Make sure Audacity is up on your computer. **Hit the Record button** (button with the red circle) and **tap the aluminum foil with your finger a few times, to make sure you can see the sound being graphed on the screen.** You may need to adjust the microphone volume up to increase the signal or down to decrease the noise. The volume can get adjusted using the slider next to the microphone icon:

   ![Volume Slider](image)

   **Go to Edit->Undo to get rid of the test recording.**

5. Two students should work together to carry out the experiment:
   - **Person 1:** **dangle the string over the piece of aluminum foil so that the weight at the end is just touching the foil.** Stand on a chair if necessary.
   - **Person 2:** **hit the record button on the computer** and tell Person 1 you have done so.
   - **Person 1:** After you get the signal from Person 2, **let go of the string.** The washers should fall one by one onto the foil, with each one making a sound when it strikes.
   - **Person 2:** **Stop the recording.**
**TEACHER NOTE**
For ease of visualizing the data at the end, it is better if the times are not too big (ie: the students don’t wait too long after starting the recording before dropping the string). If there is a delay (bigger than 10 sec or so), encourage the students to subtract a constant value (eg: 10 sec) from all the time measurements, effectively shifting what we call 0 time.

6. Look at the Audacity display and **make sure that you can see 5 peaks on the graph corresponding to each of the washers hitting the ground.** If the signal looks too messy to make out the peaks, you may need to redo the experiment. It should look something like the below image.

![Graph Image]

7. To find the time at which each washer hit the ground, **position the cursor over the peak in Audacity (using the mouse or arrow keys).** To see the peaks more closely, use the mouse to highlight all the peaks and then zoom in by going to View->Zoom to Selection getting something similar to the below image.

![Zoom Image]

Look at the bottom of the Audacity window. There should be a line that says “Selection Start:”, make sure the time there is set to hh:mm:ss + milliseconds. These numbers give the time corresponding to the cursor. **In the “Times” column, fill in the time at which each washer hit the ground.**

**TEACHER NOTE**
Encourage students to think about which part of the peaks is appropriate for the measurements. Generally, you want the very start of each peak since that is when the washer first touches the ground to make the sound.

**Q1. What does a time of 0 correspond to in this experiment?**

*Time 0 is when you start the recording. All other times are measured as the time after pressing the record button.*

**Q2. What happens to the sound peaks as more washers fall – do they remain equally spaced, move closer together, or farther apart from each other?**

*The peaks should get closer together as more washers fall*
Q3. Do you think the washers are falling faster, slower, or with the same rate as more of them hit the ground?

The washers are falling faster with time.

**TEACHER NOTE**
Encourage students to try and clap out the right rhythm to make the peaks seen on the computer screen. Ask them if they have to clap their hands faster or slower to make the peaks come closer together.

7. Fill in the “Time Interval” column with the time difference between each pair of washers hitting the ground.

Q4. Do the time intervals between the washers hitting the ground increase, decrease, or stay the same as more washers hit?

Time intervals should decrease since the peaks get closer together.

8. Calculate the velocity of the string at two different points. Remember, velocity is the distance traveled divided by the time.

\[
\text{Velocity (washers 2 & 3 falling) = distance ÷ time interval: should be about 500 cm/s}
\]
\[
\text{Velocity (washers 4 & 5 falling) = distance ÷ time interval: should be about 600 cm/s}
\]

Q5. What happens to the velocity as more washers fall? Is the string accelerating, decelerating, or going at a constant velocity?

The velocity increases as more washers fall, so the string is accelerating.

Q6. If you waited a long time after starting the recording before dropping the string, which results, if any would change?

Distances: increase / decrease / stay the same
Times: increase / decrease / stay the same
Time intervals: increase / decrease / stay the same
Velocities: increase / decrease / stay the same

Q7. Adam jumps off a table at the same time as Bob jumps off a roof. When they hit the ground, which of them will be falling faster (or will they both be falling at the same rate)?

Bob will have been falling longer, and thus will have more time to speed up due to gravity. So Bob will have a higher velocity by the time he hits the ground.

**TEACHER NOTE**
Gravity is acting like the gas pedal on a car. The longer you push on the gas pedal, the faster you will go, and the more damage you will do if you hit something.
Data Diagram:

**TEACHER NOTE**
On the student version, this is on a separate page. The page should not be stapled to the rest of the lab, so that students can refer to it easily without flipping back and forth.

*(Keep this page separate from the rest of the lab so that you can refer to it easily)*
Part 2 – Gravity and Mass

In this part, you will measure the acceleration of gravity in another way, and also look at the effect of the mass of the falling object.

Procedure:
1. Use 2 to 3 books to angle your paper towel tube to make a ramp near the edge of the table. Place a marble at the very edge of the table, right next to an open end of the tube. If you have trouble with the marble rolling away from the edge, use a piece of aluminum foil to make a slightly rough surface for it to lie on.
2. Roll another marble down the paper towel tube so that it knocks your first marble off the table. Place a piece of aluminum foil on the floor approximately where the first marble fell. Reset your ramp and marble at the edge of the table as before.

**TEACHER NOTE**
It is important for the bottom marble to be as close as possible to the table edge and also to be right up against the edge of the tube. Generally, results will be more accurate with a steeper ramp. These precautions are to minimize the time between when the microphone hears the marbles hitting and when the bottom marble actually leaves the table.

3. Just like in Part 1, one person should be in charge of recording, and one person should perform the experiment. Make sure the microphone of your computer is near the marble on the edge of the table.
4. Person 1: press the record button on Audacity
   Person 2: Roll the 2nd marble down the paper towel tube so that it knocks the first marble off the table
   Person 1: stop the recording
5. Look at the graph of sound that you recorded and find the peaks where the microphone heard the two marbles hitting and where the first marble hit the foil on the floor. Zoom in and/or play back the recording if you aren't sure which peaks are the right ones.

**TEACHER NOTE**
There will generally be two peaks at the beginning (first the marbles hitting then the top marble hitting the table) and two peaks at the end (each marble hitting the ground). The first peak is the one to use in both cases.
6. **Find the time interval between when the marble was struck and when it hit the floor.**

   **TEACHER NOTE**
   For a typical height table (70 cm), the time interval should be about 0.4 sec.

   \[
   \begin{align*}
   \text{Time when marble was struck: } & \quad \text{__________} \\
   \text{Time when marble hit the ground: } & \quad \text{__________} \\
   \text{Time interval for the marble to fall (difference of the above): } & \quad \text{__________}
   \end{align*}
   \]

7. **Now repeat the experiment using a ping-pong ball at the edge of the table.**

   **TEACHER NOTE**
   The time interval should be similar to the one above.

   \[
   \begin{align*}
   \text{Time when ping-pong ball was struck: } & \quad \text{__________} \\
   \text{Time when ping-pong ball hit the ground: } & \quad \text{__________} \\
   \text{Time interval for ping-pong ball to fall: } & \quad \text{__________}
   \end{align*}
   \]

8. **(OPTIONAL) If you have time, repeat steps 6 & 7 once more so that you have two measurements of the time interval for both the marble and the ping-pong ball.**

   **TEACHER NOTE**
   If there is time, the extra trial is useful for comparing the difference between marble and ping-pong ball to the variation between two trials of the marble and two trials of the ping-pong ball. This is a good place for a discussion of what constitutes “significant” difference (difference between marble and ping-pong ball should be comparable to difference between trials)

   **Q8. Was there a significant difference in the time of falling for the ping-pong ball versus the marble?**
   **Students should not see a significant difference.**

   **TEACHER NOTE**
   If they did not have time to do more than one trial, and it looks like one ball fell faster than the other, encourage them to look at the result of another group to see whether they got the same ball falling faster, and how much the times differed between the groups even when comparing marble to marble.

   **Q9. Does the time of falling depend on the mass of the object?**
   **No it doesn’t.**

   **Q10. Which traveled a greater distance overall in the time it took to reach the ground, the marble or the ping-pong ball? What does that mean about the horizontal speed of each ball as it rolled off the table?**
   **Ping-pong ball will travel further. It has a higher horizontal speed as it rolls off the table.**
Q11. If you shoot a bullet out of a gun and at the same time drop an apple (starting from the same height), which will reach the ground first?
They will both hit the ground at the same time, just like the ping-pong ball and marble did. The fact that the bullet has a fast horizontal speed does not affect how fast it falls.

Q12. If gravity makes all objects fall equally fast, then why does a sheet of paper fall slower than a pebble? Why does a skydiver with a parachute fall slower than one without? (both reasons are the same)
Near the surface of the planet, gravity is not the only force that affects how fast things fall. There is also air resistance from the atmosphere, which slows down a falling object (it acts like the brakes of a car). The bigger the surface of the object viewed from below, the more air it has to push out of its way, and the more air resistance it experiences. A parachute feels a lot more air resistance than just the skydiver alone.

**TEACHER NOTE**
The analogous resistance to moving water out of the way is the reason that things fall slower in a pool than they do in the air.